
Using the Inflection Dictionary

Open the chosen dictionary by selecting 'Open...' from the 'File' menu (alternatively you can use the 
Easy Open window) or double-click on icon of the dictionary. Use 'Show' menu to access the open 
dictionaries.

Browse Window
The Browse window of the Inflection Dictionary looks like that:

 

ou can browse the words here. Choose a word from the list to see the information about it.

There are two types of word-lists:
• Two Groups Split - the words from the entire dictionary can be split into two lists. You can freely move
(drag) words between these lists. This is primarily intended to keep unknown words in the left-hand 
side list (Source Vocabulary) and move the known words (My Vocabulary) to the second list. The 
Exercises engine will automatically move the words to 'My Vocabulary' list if the check-box 'Auto 
update My Vocabulary?' (in the Preferences window) is checked and you make no errors when these 
words are presented.
• Multiple Groups - the list on the left holds the words from the entire dictionary in alphabetical order 
(it presents a limited number of words at time - see the note below). You can also define many custom 
word-lists (groups): the chosen word-list is presented on the right; you can select any custom word-list 



from the pop-up menu above the right-hand scroll-list. To learn more about the custom word-lists refer 
to the section 'Custom Groups'.

Note. The lists can contain only a limited number of words. You can apply your own choice of limit in 
the Preferences window. Any limit you apply must be between 125 and 2500 words. If the number of 
words in the dictionary is higher than that, you can choose the desired set of words to be presented in 
a list in one of three ways: 
 1. Click on symbols '...>' or '<...' to move the scrolling area up or down respectively.
 2. Use the 'find' feature - type the first few letters of a word in the find box and    press the Return key 
(or click the "Find:" text - left to the find box). The list will automatically show 250-2500 words around 
the found word (the found word will be highlighted).
 3. Select the list and press a letter key (a - z) on your keyboard - the list will scroll to the first word that
starts with the chosen letter. This option can be switched on/off in the Preferences window. This 
method will not work for custom groups. A custom group cannot contain more than 2500 words.

In the box at the bottom right of the window you can type your comments about each word. Comments
are automatically saved to a disk. You can use styled text in the comments-box ('Font', 'Size' and 
'Style' menu items are available from the 'Edit' menu). There is a useful shortcut for the comments-
box. The function key F8 switches between the native and the foreign font/layout. Option-clicking on 
any word inside the comments-box will initiate the search for this word. The Tab key gives you an 
alternative way of switching the T/M pop-up menu items.

The find feature is accessible at the top left corner of the window. You should click the button (at the 
right of the find-box) to switch between the native and the foreign language modes (i.e. to look for the 
foreign language word or for its translation). To find a word you should type the beginning of it in the 
find text box (at the upper-left corner of the window) and press the return key (or click the word 'Find:' 
at the left of the find-box). Shortcut âŒ˜ F takes the cursor to the find-box.

Table Window
Table window shows you the selected group of words as a table with six columns. You can select a 
group to display from the pop-up menu '1. Group' or you can use the Groups window (see section 
'Custom Groups'). If you keep the Browse window open then option-clicking on the word in the table 
will initiate search for this word in the Browse window. You can copy the selected rows to the clipboard 
if the dictionary allows exporting (this is a decision of the dictionary author - see section 'Dictionary 
Settings'). You can save the table into a file (click 'Save' button or press âŒ˜ S).

 



ustom Groups
There is a useful feature that allows you to collect words that meet certain criteria and put them in a 
single word-list (group) for browsing, learning, or practising the exercises. These can be thematic 
groups of nouns such as plants, business, food, etc., or grammatical groups of words that share the 
same pattern of inflection, etc. If there is a large number of groups (for example I've defined 400 
custom groups for my 'Polish Nouns' inflection-dictionary), they can be collected in classes (folders) to 
allow easy access. You can, for instance, create two classes with names like 'Grammar' and 'Thematic'  
to make it easy for you to find the group you require. The plain list of groups is available from the pop-
up menus in the Browse, Table, and Exercise windows. The extended view (with classes) is available 
when you select the menu item List of Groups âŒ˜ G from the Show menu. The following Groups 
window will be shown.

 

he window will be empty if the groups are not defined. The only predefined class is 'Not Classified' and 
predefined groups are '    Not Learned' and '•Memorize•'. The three upper buttons (New, Delete and 
Rename) are for defining, deleting and renaming groups within the chosen class (you can switch 



classes in the upper pop-up menu). The two lower buttons (New and Move Gr. to Class) are for defining
new class and mowing the selected group from the current class to the class chosen in the lower pop-
up menu. When you select the group from this window then words from this group will be presented in 
the custom groups list of the Browse window.    The button Import allows importing words from a text 
file. Only the words that are in the dictionary will be imported. The check-box at the right-hand top 
corner of the window allows to hide/show the function buttons.

You can also delete groups using the Backspace key on your keyboard. You can select several groups 
and delete them with a single click.

The groups can also be defined in the Browse window. Let's assume that you want to create a list of 
nouns that are related to travel:
1. Press the New button.
2. Enter the name (for instance: 'travel') and press OK.
3. Now you can manually drag nouns from the left list to the 'travel' list. Unlike in the 'Two Groups 
Split', the nouns that you drag to the right-hand list are not removed from the left-hand list. You can 
also paste the words from the clipboard directly to chosen group (make sure that each word of text 
that you copy to the clipboard is written in a separate line).

You can use this method to define as many lists as you want. To remove a word from the group list just 
drag it back to left-hand side list, or select a word and press the Backspace key (Cut works as well). To 
remove the whole group, press the Delete button. Lists can be chosen by using the pop-up menu 
(above the word-list), or you can select List of Groups âŒ˜ G from the Show menu to open the Groups 
window (better if you have many groups). The 'Cut/Copy/Paste' operations are allowed for the custom 
word-groups. You can paste any text but only the words that are in the dictionary will be pasted.

Note. If you remove a word from the dictionary then it is removed from the main lists, but it will remain
in your custom lists. If you click this word no information will be displayed.

Abbreviations:
vt - transitive verb,
vi - intransitive verb,
vr -    reflexive verb,
perf. - perfective verb,
imperf. - imperfective verb.

Tools Window

                                 
                                        Play sound in a loop (over and over again).
                                        
                                        Play sounds associated with words from the whole group
                                        or Stop playing sound immediately.
                                        
                                        Record sound as tentative    and associate it with the chosen word.
                                        Remove tentative    sounds that are associated with the chosen word.
                                        
                                        Record sound as pattern    and associate it with the chosen word.
                                        Remove all sounds that are associated with the chosen word.
                                        
                                        Add new or change the existing words.

                                        Switch between the Browse window and the Exercises window.
                                        
                                        Assign a picture to the chosen word.

Recording and Playing Sound



You can record sounds and assign them to the chosen word. There are several options here. You can 
record sound as tentative or as pattern. To record sound as pattern you should press the P Rec. button. 
This mode is intended to save the model sounds that you want to preserve. To remove pattern sound, 
click the P Clr button. To record sound as tentative click the Rec. button. It will be appended to the 
pattern sound (if it exists). To delete the tentative sound (but preserve the pattern sound) just click the 
Clear button. The tentative sound is intended to store your speaking exercises and compare it to the 
pattern sound. You can record tentative sounds in one of two modes:
• incremental - the newly recorded sound is appended to the sounds previously recorded. To erase 
sounds click the Clear button;
• replace - the old tentative sound is automatically erased after recording the new one.
To change the mode you have to open the Preferences window from the 'Show' menu.

You can also paste sound from the clipboard instead of recording it. âŒ˜-click the Rec. or P Rec. 
button to paste the sound.

To play sound associated with a given word you should option-click (i.e. click while pressing the Option 
key) this word. If you check the 'Play Sound on Single Click?' setting (in the preferences) then pressing 
the Option key is not required. Play button plays all sounds associated with words from the chosen 
group starting at the selection point. If the group is very long the delay while gathering sounds can be 
quite long (press âŒ˜.    keys to interrupt). Check loop? check-box to play sound in a loop. You can 
listen to the new vocabulary again and again while working on your Mac with another program.

You can normally work on your Mac while listening to the sound samples. To interrupt playing sounds 
you should press the Stop or Pause button, if the wrist-watch is displayed then press the âŒ˜.    keys.

Exercises Window

 

ere, you can practice the inflection of words (the conjugation or declension), translation from Foreign to
English (F->N) or English to Foreign (N->F), and the exercises based on voice (only the pattern sounds 



are used). Choose the required exercise from the upper pop-up menu. The program presents you with 
the word in the infinitive/nominative. 

For the inflection exercises you have to choose the 'T/M' that you want to practise, and the group of 
words that should be used, and then fill the boxes with the proper forms of the word. The check boxes 
at the right are used to skip some cases from the paradigm in the inflection exercises. If you make a 
mistake, then after pressing the button all the wrongly-filled boxes are filled with the red ink and the 
STOP sign appears. 

In translation exercises you have to fill the boxes with one or more meanings of the word presented by 
the program (one meaning per box). For these exercises the 'T/M' menu is disabled because it has no 
meaning. You can use the Return key to press the upper big button. 
âŒ˜J is a shortcut for the lower big button.

You can avoid typing if you want. Just press 'Show Correct Answer' button (if you start to type your 
answer then this button will change to 'Check Answer'). Then you can decide if you've learned the 
presented word or not. The words you got wrong are automatically added to the word-groups ' Not 
Learned' and 'Memorize'. You can study these groups in the Browse window afterwards or do exercises 
with them. These words are also displayed in the 'Exercises Log'.

Alternatively you can select the Quiz exercises. You don't use keyboard for these exercises, but you 
click on word that you have to choose from the answer list. You don't need to operate the button for 
these exercises so it is grayed-out. You can practise only one person/case at time in inflection quizzes. 
You select it from the Case/Person pop-up menu.

 

ou can choose the group of words that you want to use to generate exercises from the pop-up menu. 
You can define these groups in the Multiple Groups view inside the Browse window. There are also four 
predefined groups:
• Whole Database - the entire dictionary.
• My Vocabulary - this is the right-hand list from the 'Two Groups Split'.



• Source Vocabulary - this is the left-hand list from the 'Two Groups Split'.
•    Not Learned - it contains the words that you have previously got wrong ('short memory').
•    Memorize - it contains the words that you have previously got wrong ('long memory').

The groups called ' Not Learned' and •Memorize• are predefined and handled automatically by the 
program. The program puts into these groups words that you 'answered' incorrectly during previous 
exercise sessions. These groups help you to identify words that are not correctly learned and to 
generate exercises with these words. The words you answered right are removed from the ' Not 
Learned' group immediately (short memory). The •Memorize• group contains only a limited number of 
words (you can pre-set this number) and the words are removed from this list only to make the space 
for the new words in a queue order (the words which were just added push out the oldest words).

All exercises are logged and the results can be viewed in the Exercise Log window (you can open it 
from the 'Show' menu). Pressing the Reset button will create a new entry for the 'Exercise Log'. You can
easily create your custom word-groups for practising using the Exercises Log window. Just select text 
containing the required words, choose the target word-group and press the button.

If you have defined many groups, select the menu item List of Groups âŒ˜G from the Show menu to 
open a Groups window and select the group there. If you have more than 30 groups this method is 
easier than using the pop-up menu.

You can use the tab key to move from one text-box to the next. If you do not use the Browse window 
when doing exercises then you should close it because the program automatically updates the Browse 
window to show the current word - this slows down the application.

Adding and Changing Words
If you want to add new words into the dictionary or change the existing words then you should use the 
Editor window. To open this window you should double-click inside any of the scroll word-lists of the 
Browse window. Alternatively you can click the Edit button inside the Tools window (refer to section 
'Tools Window' of this chapter). Below you can see the Editor window.

 



nter - to add a word to the dictionary or to change a word, and to save the addition or change (âŒ˜ R 
is a shortcut).
Remove - to remove a word from the dictionary (âŒ˜ D is a shortcut).
New - to clear the window to allow you to enter a new word specification.
Import - to import words from a text file.
Export - to export words to a text file (available for non-protected dictionaries only).

To add a verb or noun you have to:
• enter the basic-form (infinitive/nominative) into the 'Word' text-box ('pagare' in the example window 
snapshot);
• check the relevant check boxes and the pop-up menu;
• enter the word's meaning (see the note below);

Note.    Entering the translation of the word.
Since the translation is used for the exercises and for searching, it is important to adhere to the 
following rules for filling in the translation box. Enter all the meanings of the word. Separate each 
meaning with a comma (or a semicolon, or a colon) and a single space. If you want to add a short 
explanation that should be skipped in the translation exercises then put it into round brackets after the
meaning. For example the meaning of the Polish noun akt would be:

action, deed, certificate (of birth etc.), act (in theater)

The example of the more complicated translation for the Polish word zbyt is:

(1. noun): market (popyt), sales;    (2. adverb): too

Note that all explanations should be enclosed in brackets and followed by a separator (comma, colon, 
or semicolon). For longer explanations you should use the comments-box (in the Browse window).

if the word is regular then check the Regular? check-box, and:
    • choose the appropriate Rule from the pop-up menu (for the definitions of rules see the Rules 
Generator window);
    • if the 'Stem Procedures' are not defined then fill the 'Stems' text-box (if there are more than one 
form of the stem then type each stem in the separate line) - for the explanation of 'Stems' box see 
section 'Dictionary Settings' in the previous chapter;
    • if the word contains separable-prefix then enter it into the 'Separable prefix' text-box.

if the word is irregular then uncheck the Regular? check-box, and:
    • enter the entire paradigm in the appropriate boxes for all available 'T/M' choices.

If the paradigm for an irregular word is similar to one of the regular rules then you can:
    • check the box Regular?
    • choose the most resembling Rule from the pop-up menu;
    • fill the 'Stem' box;
    •    uncheck the Regular? check-box;
    •    correct these cases/persons that are not regular.

You can use the tab key to move from one text-box to the next. After entering all information you 
should press the Enter button to enter the newly-defined word to the dictionary. Also, if you make 
changes in any of the boxes and you want to save these changes, do not forget to press the Enter 
button.



If the Browse window is in the background it will be automatically updated - this will slow down the 
operations in the Editor window. Close the Browse window if you do not want to use it. 

If you've defined procedures in    Stem procedures then you can use the Guess (shortcut 
âŒ˜ G) button to choose rule and fill stem entries after entering the basic-form of a word. You can 
correct the entries if needed and press the Enter button to write the new word into the dictionary.

Importing Words From a Text-file
You can import the regular words from a text file.    All word in a file have to belong to the same part of 
speech (verbs or nouns). Choose the required part of speech from the pop-up menu.
The words' entries in the text file should have the following format:
• the first line of the source text file should contain text: Verbs&Nouns
• each entry has to be written in a separate line,
• each line should have the following structure:

Word[t]RuleNumber[t]Stem1[sp] Stem2 ...[t]No.[sp]vt,vi[t]Translation[t]Comment

where:
[t] - denotes a tab key;
[sp] - denotes a space;
Word - string - infinitive of a verb or nominative of a noun;
RuleNumber - integer or expression - denotes position of the rule in the Rules pop-up menu ("All Rules"
class);
Stem1[sp]Stem2 ...- string[sp]string ... - stems, you can enter up to 6 stems each separated with a 
single space;
No.[sp]vt,vi,vr -  integer[sp]string - the "No." integer code is explained below, "vt,vi,vr" string is used 
for verbs i.e. vt or vi or vr or the combination, each entry separated with a comma without a space (for
nouns can be left empty);
Translation - string - translation of the word;
Comment - string - this entry is optional.

Explanation of "no." code:
for verbs: 1 - perfective, 2 - imperfective, 3 - none,
for nouns: 4 - feminine, 5 - masculine, 6 - neuter, 7 - none.

Explanation for the expression in the RuleNumber:
a. integer - for example 5 - the number of the rule denotes position of the rule in the Rules pop-up 
menu ("All Rules" class);
b. (integer integer) - for example (3 2) - first number denotes the rule, the second number denotes a 
defect number (zero for not-defective words);
c. (integer integer string) - for example (3 2 auf) - first two numbers as explained above, the string is a
separable-prefix.

You can use any of the above expression formats at your convenience.

Example:
cantare
2
cant
3 vt,vi
sing, crow, talk

Making a backup copy of the dictionary before importing from a text file is strongly recommended. The 
importing procedure should be used with caution. The same format is used in the exported text file.

Creating Sub-dictionaries
You can create a small dictionary that contains only the words from the chosen group by using the 
Make Sub-dict. button (you should select 'Show Groups' from the pop-up menu in the top left-hand side



of the Editor window to see this button). If the group is empty then the empty database with the same 
signature and rules is created.

Merging Dictionaries
You can easily merge two dictionaries. Choose Merge... from the 'File' menu to perform this operation. 
The new words from the chosen dictionary will be added to the currently opened one. The dictionaries 
must have the same signatures to perform this operation.

You have several options for updating:
Change Inflection and Translation of Existing Words? - choose this option if you want to correct the 
potential errors in your existing inflection,
Merge Imported Comments with Existing Comments? - use this option if you want to add someone 
else's comments to your dictionary. Your comments will be preserved,
Merge Imported Sound with Existing Sound? - the sounds will be appended as pattern sounds. Your 
sounds are preserved.

Note.    There are two files associated with a single dictionary - the main file and the keys file. You need 
both of them in the same folder (but to append the dictionary you point only to the main file). If you 
want to make a copy of your dictionary in the finder then you can duplicate the whole folder with the 
dictionary files.

Note.    'Allow making changes?' check-box.
Make sure that the 'Allow making changes?' check-box is checked before making changes to the 
dictionary. Otherwise the window for the 'Dictionary Settings' is not accessible. If you are working on 
the write protected disk then the    'Allow making changes?' check-box is automatically unchecked. You 
have to check it back manually to make changes and edit the rules.


